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From the Editor

Legal Stuff
AppleUsers Spotlight is an independent magazine and has not been authorized, sponsored, or otherwise 
approved by Apple Inc.

TidBITS
TidBITS is a free weekly technology newsletter providing timely news, insightful analysis, and in-depth 
reviews to the Macintosh and Internet communities. 
Non-profit, non-commercial publications and Web sites may reprint or link to articles if full credit is given. 
Others please contact us. We do not guarantee accuracy of articles. Caveat lector. Publication, product, 
and company names may be registered trademarks of their companies. TidBITS ISSN 1090-7017.
Copyright 2009 TidBITS: Reuse governed by Creative Commons licence.
Contact us | TidBITS Web site | License terms | Full text search | Subscriptions

Trademarks
AirPort, Apple, Apple Store, Back to My Mac, Bonjour, Boot Camp, FairPlay, Final Cut, Final Cut Pro, 
GarageBand, Genius Bar, iCal, iChat, iDVD, iLife, iMac, iMix, iMovie, iPhoto, iPod, iTunes, iTunes Store, 
iWork, Keynote, Mac, Mac OS, MacBook, MacBook Air, Macintosh, Numbers, Pages, QuickTime, QuickTime 
Logo, Time Capsule, Time Machine, and Xcode are trademarks of Apple Inc., registered in the U.S. and 
other countries.
Aperture, App Store, iDisk, iPhone, iWeb, Podcast Logo, Snow Leopard, and Spotlight are trademarks of 
Apple Inc.
For a current list of other Apple trademarks, please refer to http://www.apple.com/legal/trademark/
Adobe, the Adobe logo, Acrobat, the Acrobat logo, Distiller, PostScript, and the PostScript logo are 
trademarks or registered trademarks of Adobe Systems Incorporated in the U.S. and/or other countries.
Intel, Intel Core, and Xeon are trademarks of Intel Corp. in the U.S. and other countries.
Windows is a registered trademark of Microsoft Corporation.

From the Editor
With the year end nearing, I took some time to reflect on 
my involvement with Spotlight and the journey we both 
travelled in the past couple of months. 

I recalled something Nick said which became 
increasingly evident, especially after putting out several 
Spotlight issues. It constantly fascinates me that we are 
able to work in isolation collaboratively and produce 
a quality monthly publication, despite not having met 
most of the team. To date, I’ve only met Nick and Renee 
once. And that was several months ago at the launch of 
our very first issue. 

Spotlight is the result of each of us writing, editing, 
designing, emailing (oh so much emailing), basically 
typing and clicking away (sometimes furiously) on our 
Macs at home. 

In our very own home offices.
It occured to me that it doesn’t matter if you’re 

involved in a volunteer initiative like us, or you’re a 
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student, or working from 
home, the concept of a 
‘home office’ applies across 
the board. We create a 
space, an environment that 
is most condusive for us to 
work in. Just look at the Mac 
Apps page. Enough said.

In this issue, we thought 
what would be better than 
to share some of the tools, 
tips and apps that we use 
to make our ‘home offices’ 
that little bit cosier. And 
hopefully, yours too.

 – Trish Ho

mailto:editors%40tidbits.com?subject=
http://www.tidbits.com/
http://www.tidbits.com/terms/
http://www.tidbits.com/search/
http://www.tidbits.com/about/list.html
http://www.apple.com/legal/trademark/
http://www.appleusers.org/about/
http://www.apple.com/downloads/macosx/
http://www.apple.com/downloads/macosx/
http://www.s2d6.com/x/?x=c&amp;z=s&amp;v=2190218&amp;k=dashboard
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Nicholas' Dashboard

Nicholas’ Dashboard
It has been a busy month with new products from Apple:

 • New 21.5 & 27-inch iMacs, with LED-backlit displays
 • The world’s first Multi-Touch Mouse, which is called 

Magic Mouse
 • A revamped MacBook with a polycarbonate unibody 

case
 • Updated Mac mini’s, including the new Mac mini with 

Snow Leopard Server installed
Apple never ceases to amaze us with great products. 

I particularly love the idea of the Mac mini with Snow 
Leopard Server pre-installed and I hope to cover the 
benefits of such a setup for both home users and small 
businesses, in a forthcoming issue of the AppleUsers 
Spotlight.

I don’t expect any further hardware updates from 
Apple until the new year but you never know. It would 
surprise me if we didn’t see a software update or two.

AppleUsers Monthly Contest
The new Squiz Cards have proven to be extremely 
popular with winners. There are five more pack available 
this month, so check out the opposite page for your 
chance to win one of these packs or one of the many of 
the other great prizes.

Yummy Food
We hope you enjoyed making the Apple Slice that Pam 
Doughty provided last month and I’m sure you’ll enjoy 
this month’s RECIPE recipe too. We look forward to many 
new and tasty recipes based on our favourite fruit from 
Pam in the coming months.

Until next month… 

 – Nicholas

BMUG manuals for Mac enthusiasts
Bellarine Mac User Group offers easy-to-read 
manuals focussed on real-world topics 
to help YOU become a real power user...

Unlike other bulky computer books, our coil-bound colour manuals, 
illustrated with helpful screenshots, are designed to sit beside you on 
the desk as you work through and master essential fields of Mac 
knowhow. Learn more about Safari; iMovie HD; Photoshop...

Click on this advert to go to the BMUG website. There you’ll see all 
the available titles, and you can make your choice and purchase them 
by PayPal. We will mail any 3 titles to Australian addresses for $AU20, 
or mail any 2 to an overseas address for $AU20.

http://www.squizcards.com
http://www.bellarinemac.org.au
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South AuStrAliA

SouTh AuSTrALIAN AppLE uSErS’ CLuB
Date: Friday 6
Cost: Visitors Welcomed.
Topic: Library and Reception are open from 7:00 
pm to 7:30 pm for membership payments and other 
transactions. Programmes for meetings vary between 
Presentations and Special Interest Groups which allow 
smaller groups and time for questions and answers. 
Information for New Members and Mac Novices is 
available at all meetings.
Website: http://www.saauc.org.au

SouTh AuSTrALIAN AppLE uSErS’ CLuB
Date: Wednesday 11
Cost: Visitors Welcomed
Topic: Daytime meeting that has an informal format with 
friendly group discussions the preferred order of the day. 
Bring your Mac along where possible this will enable 
members to better understand your issues and provide 
assistance. Remember “The only silly question is the one 
that is not asked”
Website: http://www.saauc.org.au

VictoriA

AuSoM INCorporATED
Date: Saturday 7
Cost: Visitors Welcomed.
Topic: 21st Century Education with Apple as a core. The 
present and future of innovative education at Coburg 
Senior High. Presenter - School Principal Don Collins) 
Website: http://ausom.net.au

BELLArINE MAC uSEr Group
Date: Tuesday 10
Cost: Visitors Welcomed.
Topic: Connecting, connecting, connecting… Have you 
wondered what’s the best way to get online while you are 
on holiday or how to go about searching for and using 
the many WiFi Hot Spots that are springing up? Have you 
thought about the possible advantages of changing your 
ISP? Do you want to setup a wireless network in your 
home? Well, don’t miss this BMUG meeting.
Website: http://www.bellarinemac.org.au

MACINToSh MuLTIMEDIA Group
Date: Tuesday 10
Cost: AUD$1 supper
Topic: Presentations are usually given by professionals 
in the Apple media space, and by trade suppliers.  All 
aspects of graphics, video, audio and related authoring 
and publishing activities are covered.
Website: http://ausom.net.au & http://www.imug.com.au

AuSoM rETIrEES AND oThErS
Date: Wednesday 11
Cost: AUD$1 morning tea
Topic: The Retirees and Others group meets each month 
to cater for the enjoyment and instruction of the growing 
population of seniors and others who are available to 
attend a daytime meeting on a weekday. The program is 
established largely on the basis of member requests.
Website: http://ausom.net.au

WeStern AuStrAliA

GErALDToN MACINToSh uSEr Group
Date: Saturday 28
Cost: Gold Coin Donation, Visitors Welcomed
Topic: Open Discussion Forum for Questions & Answers, 
followed by short presentations on topics of interest to 
attendees.
Website: http://www.gmug.org.au

neW South WAleS

AMuG SyDNEy
Date: Monday 2
Cost: Visitors Welcomed.
Topic: Monthly Monday night meeting with Q&A, 
presentation, supper and prizes. 
Website: http://homepage.mac.com/sydamug

November MUG Listings

http://www.saauc.org.au/
http://www.saauc.org.au/
http://ausom.net.au/
http://www.bellarinemac.org.au/
http://ausom.net.au/
http://www.imug.com.au/
http://ausom.net.au/
http://www.gmug.org.au/
http://homepage.mac.com/sydamug
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MACTALk huNTEr
Date: Wednesday 4
Cost: Visitors Welcome.
Topic: Steve Nichols, the Business Development 
Manager from Adobe will provide an overview of Adobe’s 
applications and online tools featuring Photoshop 
Elements 8 (photo editing software) which has just been 
released for the Mac.
Website: http://www.mactalkhunter.org.au

AMuG SyDNEy
Date: Saturday 7
Cost: Visitors Welcomed.
Topic: Saturday workshop session for one-on-one help. 
Bring your laptop or use one of the Uni’s installed Macs. 
Website: http://homepage.mac.com/sydamug

QueenSlAnd

hErvEy BAy MAC uSErS Group
Date: Thursday 5
Cost: Visitors Welcomed. Entry AUD$5  Tea and Coffee 
AUD$1
Topic: 30 Minute General Q&A Forum and panel. 
Darren, Tim, Josef and Ken — bring all your questions 
and problems for the panel. Presentation by Tim on 
Spotlight Magic,  and using eBay. Presentation by Ken  on 
iCal,  Image Capture, and Preview
Website: http://www.hbmug.com

NQMuG
Date: Tuesday 13
Cost: Visitors Welcomed.
Topic: Monthly Meeting. See web site for details of time 
and place.
Website: http://nqmug.org

AppLE-Q INC
Date: Sunday 15
Cost: Visitors Welcomed.
Topic:  Check the Apple-Q website for the latest 
information
Website:http://www.apple-q.org.au

NQMuG
Date: Tuesday 20
Cost: None
Topic: WorkShop Meeting. See web site for details of time 
and place.
Website: http://nqmug.org

If your group’s meetings aren’t listed here, please 
have your President, Secretary or another Committee 
contact us using the web form found at http://www.
appleusers.org/mug-listings/ and we’ll add them to our 
mailing list so they can submit your group’s meeting 
details each month

http://www.mactalkhunter.org.au/
http://homepage.mac.com/sydamug
http://www.hbmug.com/
http://nqmug.org
http://www.apple-q.org.au/
http://nqmug.org
http://www.commart.com.au
http://www.macvoices.com
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Contest

Nicholas Pyers

In addition to our regular sponsors of the MacBundle, 
Apress and Take Control October sees a new addition to 
the AppleUsers Contest - Squiz Cards.

Squiz Cards are the small, fun, waterproof way to 
give out your contact info to people you meet and Squiz 
have supplied us with five packs of 50 Squiz Cards and a 
keyring dispenser to give away this month. These cards 
need to be seen to see how cute, yet useful they are - to 
find out more about them, check out the ad on page 4 
and follow the link.

A new MacBundle collection is included again in 
this month’s contest. The bundle that is available to win 
depends on which bundle is active at the actual time of 
the prizes been drawn. If there is no active bundle on 
the day of the draw, then the next bundle will be made 
available to the prize winner as soon it becomes active.

Apress books are shipped from their Australian 
distributor, and winners will be contacted by Apress to 
obtain the winner’s preferred shipping address.

Take Control ebook prizes are usually emailed directly 
to winners. If they are in excess of 8MB in size (when 
zipped) then a link will be provided for the winner to 
download the ebook.

November’s Prize Pool
November’s prize bundle has ten great prizes:

 • 1 x MacBundles (whatever the current bundle is 
available at time of the contest closing)

 • 1 x iPhone for Work: Increasing Productivity for Busy 
Professionals (by Apress)

 • 1 x Creating Mac Widgets with Dashcode (by Apress)
 • 1 x Take Control of Fonts in Leopard
 • 1 x Take Control of Spam with Apple Mail
 • 5 x Squiz Card packs (each pack consisting of 50 Squiz 

Cards and a Squiz Dispenser)
Details about each individual prize can be found on the 
Contest Entry Page on the AppleUsers.org website.

How to Enter 
Entering the AppleUsers Spotlight Contest is simple. 
Simply click on the link found below, enter in your 

name, suburb and email address, along with this month’s 
magic word and click Submit. 

That’s it - You’re now entered into this month’s 
contest. 

November’s Magic Word is “Magic Mouse”

October’s Winners
The Winners of October’s contest were:

 • TheMacBundles #5, S Kast of Cameron Park
 • Learn Mac OS X Snow Leopard (by Apress), G Adam of 

Balwyn North
 • Enterprise Mac Administrator’s Guide (by Apress),  

I Henderson of Thornlie
 • Take Control of Upgrading to Snow Leopard,  

R Victoria of Fairview Park
 • Take Control of Exploring & Customizing Snow 

Leopard, R Lombardo of Padstow
 • Take Control of Mac OS X Backups, Fourth Edition,  

C Cousins of Ashtonfield
 • 5 x Squiz Card packs (50 Squiz cards & a Squiz 

Dispenser ea), P Harvey of Meadowbank, D Kadane of 
Boronia, I Bagust of Everard Park, A Harth of Gowrie 
Little Plain, B Moore of Boronia

Congratulations to all our winners last month and best of 
luck to you all this month!

November’s Contest

http://www.appleusers.org/contest/november-2009-contest/
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Take Control

Take Control of Spam with Apple Mail
Stamp out spam in 
Apple Mail by following 
email expert Joe Kissell’s 
meticulously researched 
steps! Gain insight into 
the types of spam, why 
you get so much of it, and 
how to handle fraudulent 
or malicious messages. 
This book explains how 
Apple Mail filters out 
spam, and it discusses 
eight ways to optimise the Junk Mail filter. Is spam still 
sneaking through the Junk Mail filter? Joe introduces 
you to add-on utilities that catch even more spam. Bonus 
section: Learn how rules interact with the Junk Mail 
filter,pdated for Leopard!

Includes a $5-off coupon for SpamSieve, Joe’s 
favourite spam-fighting utility! (The coupon is on the last 
page of the book.)

Questions answered in this book include:
 • How does Mail’s Junk Mail filtering really work?
 • How does the spam filter use my Previous Recipients 

list?
 • How could a spammer’s email addresses get on my 

Previous Recipients list?

 • How to avoid getting so much spam in the first place?
 • What’s the deal with email that pretends to come 

from my bank?
 • What features should I look for in a spam-fighting 

utility or service?
 • Should I try server-based filtering?

Take Control of Fonts in Leopard
Install, organize, and 
use fonts with ease in 
Leopard!

In this essential 
e-book, long-time Mac 
author Sharon Zardetto 
reveals all the details 
about how fonts work in 
Mac OS X 10.5 Leopard. 
She explains what folders 
your fonts reside in, in 
what order they load, 
and how to deal with 
font duplication. You’ll also learn the ins and outs of 
different font installation methods; how to use Font Book 
to manage, validate and organize fonts; how to make the 
most of character-rich Unicode fonts and more. Whether 
you work in a font-intensive profession, use Unicode 
fonts for non-Roman languages, or want to wrangle the 

numerous fonts that have ended up on your Mac, you 
need this e-book.

“What a splendid guide! Zardetto seems to sense 
exactly what you might need to know at just the right 
moment, but yet does not overwhelm you with a lot of 
detail all at once.”  –DFT, reviewing the Tiger edition.

Read this e-book to learn the answers to questions 
such as:

 • What’s new with fonts and Font Book in Leopard?
 • What types of fonts can I use with Leopard?
 • How does automatic font activation work?
 • In what order does Leopard access fonts from all their 

possible locations?
 • How can I figure out what characters are available in a 

Unicode font?
 • Which fonts can I remove from my system safely?
 • How can I best organise the fonts stored on my Mac?
 • What is the logic and organization for Adobe’s various 

CS products?
 • How are fonts from Microsoft Office 2004 and 2008 

stored?
 • How should I handle fonts from Apple’s iLife and 

iWork suites?
 • How can I minimize font trouble when sharing 

documents across platforms?
 • What aspects of using fonts have changed between 

Mac OS X 10.5 and 10.5.5?

http://www.takecontrolbooks.com/spam-apple-mail
http://www.takecontrolbooks.com/leopard-fonts
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What's new

DrawIt 3.10 for oS X – 
powerful vector-Drawing
Bohemian Coding 
recently announced 
DrawIt 3.10, the latest 
version of their easy-to-
use, powerful vector-
drawing application 
for Mac OS X. DrawIt is 
unique in that it presents 
the user with a simple 
and clean interface, yet 
packs an impressive assortment of useful, professional 
features. In version 3.10, the interface has been further 
simplified and powerful features have been added.

DrawIt 3.10 has become a lot faster than its 
predecessor when working on a large canvas or with a 
large number of layers. Memory usage has gone down 
significantly – in some cases even consuming less than a 
tenth compared to its predecessor.

Often requested in DrawIt was support for multi-stop 
gradients. DrawIt 3.10 finally delivers this feature and 
also adds a gradient stroke effect to the mix. One of the 
strengths of DrawIt has always been its ability to add 
multiple effects of the same kind to a single layer, and 
with the improved gradient filters this is even easier.

What’s new:
 • Adds flexible multi-stop gradient and gradient stroke 

effects
 • Significant performance increase
 • Updated UI

Minimum requirements:
Mac OS X Version 10.6 or higher

pricing and Availability:
DrawIt 3.10 is available for free as a full-featured 

demo for 30 days. A single user license is 29.00 Euros 
(US$40.00). Registered 3.x customers may upgrade for 
free.

More information on DrawIt 3.10

What’s New
EyeTv app brings live Tv to 
the iphone
The new EyeTV app has 
zoomed to the top of the 
charts since it was introduced 
last week. Apple has listed 
the EyeTV app as “New and 
Noteworthy”, and it quickly hit 
the Top 5 in the entertainment 
category as well as one of the 
Top 10 paid apps in many App 
stores worldwide.

Features
 • The EyeTV application accesses EyeTV running on 

your Mac at home to deliver these great features to 
your iPhone:

 • Watch live TV and change channels anywhere (Wi-Fi 
connection required)

 • Watch your EyeTV recordings
 • Browse the comprehensive Program Guide
 • Start recordings back home on your Mac immediately 

or schedule them for later
 • View and edit your recording schedules

Absolutely no configuration is necessary to watch 
live TV on the same network as the Mac that is running 
EyeTV. To watch live TV when you are on the road, Elgato’s 
free My EyeTV service helps the EyeTV app find your Mac 
at home. If your equipment is not compatible and the 

http://www.bohemiancoding.com/drawit
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My EyeTV service is not able to find your Mac, you can 
configure your router manually. A word of caution: This is 
not recommended for novices! Please don’t try this if you 
are not familiar with the term “port forwarding”.

The EyeTV app is available from the App Store at a 
price of AU$5.99.

Important information
 • A Mac running EyeTV 3.2 or higher is required; the 

EyeTV running on your Mac converts live TV to the 
correct format for streaming to the iPhone

 • Live Streaming requires an Intel Core 2 Duo processor 
or better

 • iPhone OS 3.0 or higher

Purchase EyeTV App
Download EyeTV 3.2

MacSupportCasts Launches 
New video Tutorial Site
Long-time Mac users 
and industry experts 
Larry Pollock and Kevin 
Burns are excited to 
announce the launch of 
MacSupportCasts, a new 
online video tutorial 
website designed to 
provide affordable online Mac training to users ranging in 
expertise from novice to intermediate.

“I think users who are new to Macs or even old ‘die 
hards’ will get a kick out of the tutorials that we have 
put together,” says co-founder Kevin Burns, a veteran 
Mac user and business consultant with over 15 years of 
experience developing software and running large-scale 
projects for blue-chip companies. “It’s like having 24/7 
access to a very affordable Genius Bar - and you don’t 
even have to wait!”

MacSupportCasts’s easy-to-use video tutorials (also 
known as Video Casts or simply “casts”) begin with the 
fundamentals of using a Mac computer and then move 
into more detailed training on each application included 
with a Mac. Each application-specific tutorial is presented 
in the same manner as the initial introductory casts 
and covers the basics of using the application menus, 
buttons, preferences, templates (where applicable) and 
other details where appropriate.

Most casts also include a great practical 
demonstration of the application in action. This is 
especially beneficial for users of applications like Pages 
(part of the iWork collection). Casts are currently under 

construction to show examples of creating brochures, 
flyers and other designs.

All tutorials are kept short. Average run time is 
3–10 minutes, with a few exceptions where needed. 
Currently there are over 85 casts with over 200 expected 
to be posted by the end of the year. New and updated 
tutorials are added each week. Videos are viewed online 
via streaming video at a superb 1280 x 720 full screen 
resolution.

Co-founder and Lead Caster Larry Pollock says that 
he thinks MacSupportCasts users will be excited about 
the short, casual and easy-to-follow tutorials. “By keeping 
our casts short, users will find it easy to learn and retain 
information. Keeping them casual accomplishes our goal 
of being like a good friend sitting next to you helping.”

Both Pollock and Burns have a vision of creating 
the largest selection of Mac tutorial videos available 
online while also keeping it cost effective. All access 
memberships are available for one, two or three years.

http://www.s2d6.com/x/?x=c&z=s&v=2190188&t=http%253A%252F%252Fitunes.apple.com%252FWebObjects%252FMZStore.woa%252Fwa%252FviewSoftware%253Fid%253D329886711%2526mt%253D8%2526uo%253D6%2526partnerId%253D1002
http://www.elgato.com/elgato/int/mainmenu/support/Update-Start/Update-EyeTV-3-2.en.html
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pricing:
1-Year Membership - US$47
2-Year Membership - US$77
3-Year Membership - US$97
Access Level: Unlimited

Minimum recommended requirements: 
 • Mac OS X Version 10.4.11 Tiger or 10.5.2 Leopard 
 • Latest version of Safari, Firefox, Opera or Google 

Chrome recommended 
 • Javascript active in browser
 • Latest Quicktime
 • Latest Flash Player

MacSupportCasts
Membership Information

MyStuff 1.0 - the First Stuff 
Manager for oS X
Minder Softworks has released MYStuff 1.0, designed to 
be the first “stuff manager” for OS X. Combining the best 
features of PDF managers and home inventory programs, 
MYStuff adds additional features, and gives users an 
intuitive way of filing and finding their information.

MYStuff makes it easy to file and find information 
about the things you own. You simply make a new record, 
and key in what you bought, where you bought it, how 
much you paid for it, warranty information and other 
key data. Then you can add an unlimited number of files 
to the record: a scan of the receipt, photos of the item, 
a PDF of the manual and anything else you would like 
to add. To make this process easier, MYStuff’s MYInbox 
feature allows users to quickly add files to MYStuff from 
other applications.

MYStuff will immediately draw comparisons to 
popular PDF- and note-managing applications, home-
inventory applications, receipt-tracking applications and 
warranty-tracking applications. MYStuff is none of these 
things, and yet it is all of these things. PDF managers 
concentrate on allowing users to file and find documents, 
but provide no way of entering information about 
individual items. Home inventory programs allow for 
tracking information about individual items, but provide 
little or no way to track the documents about the item.

MYStuff has all the best features of each of these 
applications, and puts them in a simple, easy-to-use 
interface. In addition to these features, MYStuff allows 
you to easily back up your data, print lists for insurance 
claims and view your records as lists or as images.

Every year, people throw away countless products 
that are still covered by a warranty. Most often, they are 

unaware that the product is still under warranty because 
they cannot find the receipt and warranty information 
from the purchase a year ago or maybe ten years ago. 
As a result, they replace an item that could have been 
repaired for free, and waste money. Keeping important 
paperwork organised is a tremendous amount of work, 
which explains why so few people do it. MYStuff helps 
users file and find their information quickly and easily, 
saving both time and money.

Minimum requirements:
MYStuff will run on any Intel or PowerPC Mac running 

OS X 10.5.8 or later, including Snow Leopard

pricing and Availability:
A free demo is available from the website. A full 

license can be purchased for US$29.
More Information about MYStuff 1.0

http://www.macsupportcasts.com/
http://macsupportcasts.com/join/
http://www.mindersoftworks.com/products/mystuff
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Typinator 3.6 - Sync Text 
Snippets with Dropbox
Ergonis Software today announced the release and 
immediate availability of Typinator 3.6, the new version 
of its highly acclaimed text expansion tool for auto-
typing text and auto-correcting typos. The new version 
supports Dropbox, an online platform and software 
that automatically syncronises your files across your 
computers.

Setting up Typinator for using Dropbox 
synchronization is as easy as defining Typinator’s set 
folder to be located inside your Dropbox folder with 
a new preferences setting. Now your snippets will be 
instantly available on any of your other computers that 
you’ve configured that way. 

Typinator 3.6 furthermore implements a long list 
of improvements and other changes, including further 
speed enhancements and increased compatibility with 
Mac OS X 10.6 (Snow Leopard) and many third party 
applications. 

“Until recently, MobileMe was the only available 
choice to automatically synchronise data across several 
Macs. However, since MobileMe requires an annual 
subscription fee, many Mac users declined to use it. 
With a free basic Dropbox account you get 2 GB of 
online storage - much more than you will ever need for 
your Typinator snippets,” said Christoph Reichenberger, 
founder and CEO of Ergonis Software. “Synchronising 
your Typinator snippets base with Dropbox is the ideal 
solution for having a consistent set of snippets available 
at your desktop Mac and your laptop at any time.”

Typinator is a powerful, yet elegantly simple solution 
that works across all applications. It detects specific 

sequences of typed characters and automatically 
replaces them with text snippets, graphics, URLs, dates 
and special characters.

For business users, Typinator leads to a layer of 
operational consistency and productivity across 
heterogeneous applications. A standard customer 
service response, a signature image on an email, a clause 
in a contract - each of these can be inserted in any 
application with just a couple of keystrokes. For technical 
users, Typinator automates typing of code and the 
implementation of documentation standards.

System requirements:
Typinator 3.6 requires Mac OS X version 10.4 or 

newer and is fully compatible with Mac OS X 10.6 (Snow 
Leopard). Mac OS X 10.6 or newer is recommended. 
Typinator 3.6 is a recommended update for everyone 
running on Snow Leopard.

Availability and ordering: 
Typinator can be purchased securely on the Ergonis 

Software website. The upgrade to Typinator 3.6 is free for 
all customers who purchased Typinator in the last 2 years. 
For information about purchases, including enterprise 
licenses, volume discounts and upgrade pricing offers, 
see the company’s website. Visit Ergonis Software’s 
website to learn more about the changes in this release 
and to download and try the new version.

Instead of purchasing Typinator by itself, customers 
can get the Macility Productivity Bundle that also 
contains two of the company’s other productivity tools, 
PopChar X and KeyCue. The pricing of the Productivity 
Bundle represents savings of more than 35% over the 
separate purchase of its components.

Typinator 3.6

http://www.ergonis.com/products/typinator
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Method
1. Place the oats in a large bowl and stir through the 

milk and allow to stand covered, preferably overnight.

2. Cut 2 of the apples into quarters and leaving the skin 
on, coarsely grate. Toss in the lemon juice and stir into 
the oat mixture.

3. Stir through the dried fruit and yoghurt. 

4. When ready to serve, scatter over the hazelnuts, 
pepitas and sesame seeds.

5. Divide in to 4 bowls. 

6. Slice the remaining apples and put on top. Drizzle 
with honey to taste.

Spotlight Cooks: Apple bircher muesli
Pam Doughty

Notes:
 • If working in the ‘home office’ means you find yourself 

tempted by junk food one remedy can be to have a 
satisfying breakfast before you start. This recipe may 
be modified with different fruits and nuts for a quick 
snack during the day.

 • Try mixed berries or sliced banana in place of the 
dried fruit and replace the suggested nuts and seeds 
with your favourites.

 • Replace the natural yoghurt and honey with flavoured 
yoghurt.

 • If you have apple juice available add up to a cup to 
the milk and oats mixture.

Ingredients
2 cups rolled oats 

1 cup milk

2 lemons, juiced 

3 apples 

4 tablespoons dried fruit e.g. sultanas, dried pears or 
apricots

½ cup natural yogurt and honey to taste.

2 tablespoons roughly chopped roasted hazelnuts 

1 tablespoon pepitas 

2 teaspoons sunflower seeds 

2 teaspoons sesame seeds

  

AMUG Sydney
PO Box 304 Mortdale 2223
Ph 9387 2069 • Fax 9387 3227
Email: sydamug@me.com

homepage.mac.com/sydamug/

 …then come along to our 

Saturday Workshop 
Held monthly at the University of NSW, 
Kensington, Webster Building, in the 
computer lab, Level 1. 10am-2pm. 
One person per computer – use the 
installed Macs or bring your own Apple 
notebook. See web site for dates.  
Email us for Bookings. 

http://homepage.mac.com/sydamug
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D ropbox has released the Dropbox app. It is an 
iPhone utility for accessing files stored in a 
Dropbox account. It allows you you to view any 

iPhone-supported document types — text documents, 
Word, PDF and movie files — and share them from within 
the app.

The Dropbox service enables you to synchronise files 
in selected folders among multiple computers, including 
those running OS X, Linux and Windows. Files are also 
accessible via the Web. The company offers 2 GB of 
storage for free. Additional space costs extra. Dropbox 
also stores older versions of your files — either 30 days 
worth or unlimited, depending on your account type. 
You can share subfolders with others, and make photo 
galleries publicly available. (For more details about 
Dropbox, see “Dropbox: A Collaborator’s Dream,” 2009-
02-03.)

The new Dropbox app integrates with the iPhone, 
and lets you store files locally on it for offline access. You 
can also upload photos and videos on your iPhone or 
capture new ones directly from within the Dropbox app.

After setting up a new account or entering account 
details, you’re presented with a view of your Dropbox 
folder.

Tap a folder to see its contents or tap a file to view it. 
While viewing a file tap the favourite icon  to store the file 
locally for offline viewing. Stored items are found in the 
Favorites view available via any file list. Older versions of 
files aren’t accessible from the app.

You can share an item you’re viewing by tapping 
the envelope icon. This generates an in-app email 
message with an embedded link. Unfortunately, you 
can’t configure folder sharing from within the app, 
which currently requires a trip to your account via your 
computer.

Nor can you email someone a download link without 
first transferring the file to your iPhone (as you can with 
SugarSync; see “SugarSync Sweetens Online Syncing,” 
2008-08-30), which can take a long time for large files, 
especially if Wi-Fi is unavailable.

It would also be nice to be able to set an expiration 
date and a password, as with MobileMe’s iDisk option to 
email a link to a file.

In a file list, you can tap the camera icon at upper right 
and take a picture, record a video (on the iPhone 3GS) or 
upload a photo or movie from the iPhone’s stored media. 
If you already have a photo gallery set up, you could drop 
the image or movie into that directly, updating what 
visitors see.

Dropbox carries over another bit of its gallery feature 
to the iPhone. With any image selected, Dropbox adds 

Dropbox releases iphone App for File viewing and Sharing
Glenn Fleishman <glenn@tidbits.com>

Dropbox File List View View Document Share Email

http://db.tidbits.com/article/10048
http://db.tidbits.com/article/9751
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back-and-forth navigation arrows at the bottom to view 
other images in the folder. A See All button at upper right 
reveals a gallery view of all readable images at the same 
folder level.

The Dropbox app is definitely a welcome adjunct to 
the rest of the service and would have saved me much 
monkeying around recently when I was officiating at a 
wedding out of town. Leaving my iPhone behind, I used 
the Air Sharing app to copy a few critical Word files and 
PDFs with schedule information and my remarks for the 
wedding. With the Dropbox app, however, I would have 
had them available. 

https://www.getdropbox.com/home
https://www.getdropbox.com/iphoneapp

Take Photo One Photo Gallery View

E V E N T S
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O F F I C E :  (03)9842 2561 M O B :  0404 771 875

E X P E R I E N C E D  E V E N T  M A N A G E R S  A N D  T R A I N E D  D J ’ S ,  L I G H T I N G  D E S I G N E R S  
A N D  H O S T S  A L L  R E A D Y  F O R  Y O U R  E V E N T  N O  M A T T E R  T H E  S I Z E ,  C L A S S  O R  S T Y L E .
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O ne of the lesser-known changes in Snow Leopard 
is the removal of the old AppleTalk networking 
protocol, which Apple has deprecated for 

years. But even though most networking devices 
stopped supporting AppleTalk long ago, largely due to 
improvements in other areas, one area where AppleTalk 
has long been used is in printers.

Not new printers, of course. But many older printers 
- the workhorses of the 1990s - are still humming 
along fine. Although it’s become more difficult to 
find replacement toner cartridges, and they’re quite 
expensive when you do need to buy them, if the printer 
works well and does what you need (and if you don’t 
print a lot), it’s hard to justify junking it.

That was the case for my beloved LaserWriter Pro 
630, which I’ve used since 1994, but which I wasn’t able 
to print to once I upgraded to Snow Leopard. After quite 
some effort, I was able to bring it back online and use it 
via Snow Leopard. Although people with other old Apple 
printers may not be able to follow my path exactly, I hope 
my basic approach will help point in the right direction.

Oddly, Apple claims that Snow Leopard includes 
the necessary software to print to the LaserWriter Pro 
630, but the company doesn’t say how to work around 
the removal of the AppleTalk support necessary to 
communicate with the printer.

Apple LaserWriter Pro 630

Back to Basics
I started by considering what makes up a LaserWriter 

Pro 630. It has a Canon EX print engine, a hardware 
PostScript Level 2 interpreter and a print server that can 
use only EtherTalk as a means of transport. (EtherTalk 
is AppleTalk over Ethernet, and is the weak link in this 
scenario.)

The LaserWriter Pro 630 predates the graphical Web 
browser, so Web configuration and the Internet Printing 
Protocol (IPP) clearly weren’t options, and even TCP as 
transport layer wasn’t going to be available. So it was 

clear that I had to forget about the printer’s Ethernet port 
and the communication capabilities behind it. But then 
how could my Mac talk to the PostScript interpreter and 
the print engine?

Since these older printers had to work with computers 
other than Macs (and because they were often based 
on hardware used by other cross-platform printer 
manufacturers), they often had other communication 
ports as well. This particular printer has four possibilities 
beyond Ethernet:

LocalTalk port (RS-422): This network port would 
seem to be a possibility, with the addition of an Ethernet-
to-LocalTalk bridge from a manufacturer like Asante (look 
for the Asante FriendlyNet Ethernet to LocalTalk Bridge; 
for more discussion, see the old and likely obsolete article 
“Printer Sharing and Print Spooling in Mac OS X,” 2003-
03-31). They’re not made any more, but if you have one 
around, it could be worth trying. However, there are two 
problems with using the LocalTalk port. First, since it hails 
from the same era as the printer’s Ethernet port, it likely 
won’t work with Snow Leopard’s modern networking and 
printing technologies, and second, with a throughput of 
only 230.4 Kbps, it might be awfully slow.

Centronics-style parallel port: Parallel ports used to 
be commonplace for connecting printers to PCs. It was 
almost unthinkable that anyone would ever use this port 

Make old Apple printers Work in Snow Leopard
Christian Voelker <c.voelker@gmx.net>

http://support.apple.com/kb/HT3669#apple
http://db.tidbits.com/article/7129
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to print from a Mac, but what if I could find a parallel print 
server that would plug into the printer and which I could 
connect to via Ethernet?

Serial port (RS-232): Serial ports were less commonly 
used than parallel ports for printing, but if I couldn’t find 
a parallel port print server, perhaps I could get a serial 
print server that would meet the same needs, if at a 
slower speed than the parallel port.

SCSI port: Although it’s a communication interface, 
SCSI on printers was used almost entirely for connecting 
a hard disk that would store downloadable fonts or 
commonly used background art.

Do Parallel Ports Ever Meet?
I first looked for “parallel print server” on eBay and 

bought a widely used but now discontinued D-Link DP-
301+. Beware of this model, which sounds good when 
you read about it online. It, like all of these small parallel 
print servers, has a severe design flaw. It lacks an external 
reset button, so once configured (as most used units 
would be), you can’t reset it without using its built-in Web 
interface. In this case, it is not only difficult to find the 
device’s IP address, but it remains inaccessible unless you 
have the proper password. Unfortunately, the seller didn’t 
know the password, since a former friend of his had 
configured it, and I was happy to return it.

After some more searching, I bought a new Netgear 
Mini Print Server PS101 parallel print server. It is also 
quite common, even smaller than the D-Link unit, and 
from a company I like. It was a bit more expensive, but 
easier to set up. If there was a password on the device, 
you would need a Windows machine (or possibly VMware 
Fusion or Parallels Desktop) to run the Windows software 
that’s required for resetting, but at least there is such an 
option.

Netgear Mini Print Server PS101

The Netgear PS101 gets its IP address via DHCP, so 
you can figure it out by scanning for devices on your LAN 
using the Angry IP Scanner utility (scan once before you 
plug in the PS101, and once afterwards, and look for the 
new device). With an AirPort base station, you can also 
use the DHCP Clients tab in AirPort Utility (Advanced 
> Logs and Statistics > DHCP Clients) to monitor a new 
client being added. Once you’ve found the PS101, you 
can connect to its Web interface via a browser. There’s not 
much to configure in the Web interface; just finding the 
IP address is the key.

Once I had the IP address of the print server, I was 
ready to go... or so I thought. I opened the Print & Fax 
preference pane on my Mac and started to add a new 
printer. But what exactly to enter? Selecting the IP 
button was fairly obvious, but which protocol is right? 
The default LPD? The modern IPP? The proprietary but 
widely supported Jetdirect? I could tell from a port scan 
in Network Utility that the Netgear print server used port 
515 and 9100, and a quick Google search showed that 
515 was used for LPD and 9100 was used for Jetdirect.

I added a printer for both of these protocols, but to no 
avail. Both printer connections showed up with a green 
light in the Print & Fax preference pane’s printer list, but 
with LPD, printing a page timed out after more than a 
minute. Jetdirect was slightly more promising, printing 
a lot of garbage, indicating that at least there was 
communication taking place.

Initially, I thought the problem might be PostScript 3 
code being sent to a PostScript 2 printer, but that turned 
out not to be the issue. I had overlooked one last thing to 
configure on the printer - how to tell it to communicate 
properly with the parallel port. Time to read the manual. 
As if I still had that around after 15 years...

Luckily, Apple provides manuals for older products 
online. I found and downloaded the manual for my 
LaserWriter Pro 630, but it was entirely in Courier, with 
no styles or graphics. Lest you think I’m complaining 
about aesthetics, the problem was that the information 
I needed was in a table in Appendix C (page 60), and it 
took me nearly an hour to figure out how to interpret the 
mass of monospaced text. (Line numbers are missing, 
but each setting corresponds to four lines, each of which 
describes one communication method, so I looked at the 
Parallel line for each setting.)

On the left rear top of the LaserWriter Pro 630, 
above all the connectors, there is a tiny wheel that 
offers 10 settings. Unfortunately, the LaserWriter Utility 
application is not available any longer under Mac OS X. 
With it, I could have enabled a setting that would print a 
configuration page when the printer turned on, and that 
page would have displayed the current communication 
settings.

But reading the table in Appendix C gave the clues 
I needed. The wheel was set to 0 to start with, which 
corresponded to a “Normal” connection and “PostScript” 
as the Control Protocol Mode. I knew those values didn’t 
work via the parallel port, which also eliminated settings 
2, 4, 5, 6, and 7. Settings 1 and 3 used “Raw” as the 
connection and “HP PCL 4” as the Control Protocol Mode, 
whereas setting 9 used “BSP” as the connection and 
“PostScript” as the Control Protocol Mode.

Since I knew I wanted the printer to interpret 

http://www.dlink.com/products/?pid=322
http://www.dlink.com/products/?pid=322
http://www.netgear.com/Products/PrintServers/WiredPrintServers/PS101.aspx
http://www.netgear.com/Products/PrintServers/WiredPrintServers/PS101.aspx
http://www.angryip.org/w/Home
http://docs.info.apple.com/article.html?artnum=50128
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PostScript and not HP’s PCL (Printer Command Language), I chose setting 9 even though 
I have no idea what connection type “BSP” involves, and printed a test page. It worked! 
My LaserWriter Pro 630 had returned to the land of the living without being savaged by 
Snow Leopard!

It gets better. Because my FritzBox Wi-Fi gateway doesn’t route AppleTalk between 
the Wi-Fi and Ethernet segments of my network, I previously couldn’t print from my 
MacBook unless I plugged the MacBook into my Ethernet network. Because this new 
setup doesn’t use AppleTalk, I can now print wirelessly from my MacBook, sans Ethernet 
cable.

Extrapolating to Other Printers
Although I’m pretty sure this approach will work fine for those with a LaserWriter Pro 

630, other old Apple printers may lack a parallel port or may have an entirely different 
method of changing the parallel port’s connection mode.

But if your printer has a parallel port and perusal of the original manual implies 
that you can tweak the connection settings with a hardware switch (rather than the 
LaserWriter Utility), give the Netgear PS101 print server a try. There are also plenty of 
other parallel and even serial print servers, some with Wi-Fi, that might work.

I do wish Apple would give more hints about how to continue using a theoretically 
supported Apple printer under Snow Leopard. Suggestions for Ethernet-to-parallel/serial 
print servers and an explanation of what Normal, Raw, and BSP mean with respect to 
connection types would be welcome.

Unless - I won’t say “until” - they do, however, I hope my attempt here at explaining 
how I brought my LaserWriter Pro 630 back into service under Snow Leopard will help 
others keep their perfectly functional old printers humming along.

Credits
Christian Voelker works as a network admin in an advertising agency in Hamburg, 

Germany, and specializes in archival solutions based on DuraSpace and DSpace. His long 
term pet project is a local history archive for citizens of Hamburg.

Introducing our BRAND NEW online store for all your Apple 
needs, shipped directly to you from our warehouse!

www.store.widebaytechnology.com.au

Looking for a better Apple Mac deal online?

So come on over and check out our already discounted prices!
Plus, as a special only available to the readers of The AppleUsers Spotlight we 
are offering (until the end of August) FREE shipping Australia Wide on any 
Apple Mac System purchased.

DISCOUNT COUPON:
Good for FREE SHIPPING 
on all Mac Systems

COUPON CODE:

WBT38942
(Valid until August 31st)

Feel free to Email us if you have any questions:
shop@widebaytechnology.com.au

http://stadtteilgeschichten.net/
http://www.widebaytechnology.com.au
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I bought my husband a 
Nikon D50 for Christmas 
a few years back and 
needless to say, he’s 
totally obsessed with it. 
He’s snapping pictures 
constantly and has 
outfitted it with a couple 
of new lenses, a speed 
flash and several multi-
gig memory cards. He’s 
all set, that is, until he 

transfers the images onto his Mac.
He doesn’t know squat about resizing an image for 

print or an email. He’s heard of resolution but doesn’t 
have a clue what it means or when it matters.

Today I’m going to show you (and my husband) how 
to resize images with ease using Photoshop Elements. 
It’s an amazingly powerful piece of software that’s under 
US$80. I’ll start by covering basic graphic terminology 
and exploring the relationship between resolution and 
pixels. 

What is resolution?
Image resolution is the number of pixels displayed per 
unit of printed length in an image. It’s a measurement 
used for printing (hence the phrase “of printed length”) 
and it’s usually stated in pixels per inch (ppi – used when 
referencing stuff onscreen) or dots per inch (dpi – used 
when referencing something that’s about to be printed 
because printers print dots).

What is a pixel?
The smallest picture element of any digital image is called 
a pixel. Images are displayed in tiny blocks (also referred 
to as dots) of colour that together form an entire image. 
If you zoom into an image around 300% or so, you’ll start 
to see them. TIP: In Elements, just press Command + several 
times to zoom in, then Command - to zoom back out.

How do resolution and pixels work together?
 For a given number of pixels in the width or height of an 
image, any image can be measured at any resolution. The 
higher the resolution, the closer the printer packs those 
pixels together in order to make a beautifully smooth and 
sharp print. The closer the pixels are packed together, 
the smaller the image will be physically when it’s printed. 
Conversely, the lower the resolution, the more loosely 

those pixels are packed and the larger the image can be 
physically – though it will print terribly, looking pixelated 
and chunky.

Imagine the pixels in an image were granules of 
brown sugar (stay with me, it’ll make sense in a minute). 
If you pour brown sugar into a measuring cup without 
packing it down, it might take up about a cup in space. 
If you were to pack it down with your fist, the same 
number of granules now takes up a 1/2 cup of space. The 
same amount of granules are in both a cup and 1/2 cup, 
it’s just the density that’s changed thereby changing 
how much physical space the granules comprise. Loosely 
packed granules are the equivalent of low resolution, 
while densely packed granules are the equivalent of high 
resolution.

Because our monitors can only display a certain 
amount of information that our eyeballs/brains can 
process, resolution changes cannot be seen onscreen. 
Resolution only matters to printing devices (and 
technically scanners but that’s fodder for another 
column). That’s right, resolution doesn’t mean a hill of 
beans until that image is headed for a printer, because 
only a printer can do anything with the resolution 
measurement. Your monitor just doesn’t care: A 72 ppi 
image will look exactly the same as a 3000 ppi image. 
That’s why the whole resolution issue is so confusing.

How much do I need?
Now that you understand how resolution works, how 
much resolution do you need to make a gorgeous print? 
It depends on the printer. While the current crop of 

How to resize images from digital cameras
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consumer-level inkjet printers do a fine job at 225-250 
ppi, a professional service bureau may require 300+. If 
it’s your own printer, run a few tests. If someone else is 
printing it, ask them what resolution they need – and if 
they don’t know, find another printer – fast.

How do I resize a photo for print?
Let’s take a photo from a high-quality digital camera. 

I popped open the photo in Elements and took a peek at 
its Image Size dialog to see what the resolution currently 
is and how many pixels we have to work with. You can 
open this dialog by choosing File > Resize > Image Size. 
As you can see below, my photo is 2599 x 1949 pixels, but 
only 72 ppi. Does this mean my photo is low-quality and 
unsuitable for print? Not at all. It merely means that the 
resolution needs to be changed before I try to print it.

2. Note the pixel dimensions shown in the upper 
portion of the Image Size dialog: 2599 x 1949 (also 
circled in red). Remember these numbers.

3. Note how big this image is. If I were to try printing 
at its current resolution, it’d be over 36 inches by 27 
inches... INCHES! I don’t know about you but I don’t 
have a large format printer!

Now, watch carefully as I increase the resolution of the 
image without altering the number of pixels.
Step 1:  (see Picture 2) In Photoshop Elements, choose 

Image > Resize > Image Size. (In Photoshop, 
choose Image > Image Size.) TIP: Keyboard 
shortcut for either software: Command + Option + I.

Step 2:  (see Picture 3) At the bottom of the dialog, 
uncheck Resample Image. This powerful, magic 
option locks the number of pixels contained in 
the image, thereby locking quality. Enter 300 into 
the resolution box and watch how the document 
size changes:

The image now has a resolution of 300 ppi and the 
physical size has decreased to about 8.5 x 6 inches. Notice 
how the physical dimensions of the image changed 
but the pixel information didn’t. I have exactly the same 
number of pixels I started out with – 2599 x 1949 – 
they’re just packed more tightly together. The file size 
didn’t change at all – it’s still 14.4 MB, as evidenced in the 
document window and in the Image Size dialog (another 
clue that the pixel data didn’t change). I haven’t changed 
the quality (pixels), I’ve just changed the measurement 
(ppi) which only affects the printed image.

Again, this is confusing because the onscreen image 
won’t change a bit (see earlier paragraph on monitors, 
eyeballs and brains). The truth is only revealed by the 
Image Size dialog. The thing to remember is that as 

long as you uncheck the Resample Image box, you can 
tweak the resolution till the cows come home and you 
won’t alter the image quality at all. Ever. If you leave the 
Resample Image box checked, though, you’re messing 
with photo quality which you don’t want to do when 
printing. If you’re resizing an image for email or posting 
on a website, then leave the Resample Image box check 
because in those cases you really do want to lower pixel 
dimensions, thus lowering file size.

Picture 1

Picture 2. In Photoshop Elements, choose Image > Resize > Image Size.

Picture 3. At the bottom of the dialog, uncheck Resample Image.

Important things to note (see Picture 1):
1. At the bottom of the document window, you can see 

that the file is big – 14.4 MB (circled in red above).
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How can I make Elements do it for me?
If you want to print a photo at a common size like 8 x 10 
or 5 x 7, you can have Elements change the resolution for 
you. Just choose File > Print and pick a size from the Print 
Size pop-up menu towards the top of the dialog.

Picture 4. you can have Elements change the resolution for you.

Picture 6. You can resize the image and change the resolution 
simultaneously by using the Crop tool

Picture 7. With the new Elements 6, resizing an image for email has 
never been easier.

How can I resize for an email?
With the new Elements 6, resizing an image for email 
has never been easier. Just click the green Share tab 
at the top right of the interface and press the Email 
Attachments button (circled below in red). If the image is 
too big, Elements will alert you with a dialog and offer to 
resize it for you.

How can I resize and change resolution at the 
same time?
You can resize the image and change the resolution 
simultaneously by using the Crop tool.
Step 1:  Press C to select the Crop tool in either 

Photoshop or Elements.
Step 2:  In the Options bar at the top of your screen, enter 

the dimensions of the desired image and the 
resulting resolution. Be sure to include the unit 
of measurement in the width and height boxes 

(see Picture 6). Draw a box around the important 
bits of your image and when you get it just right, 
press Return to accept the crop. Press the Escape 
key to exit a crop.

WArNING: If the image appears to enlarge on your 
screen, then you’ve surpassed the number of available 
pixels. In other words, you’re trying to print it larger than 
it can really go at the resolution you’ve entered. If that 
happens, press Command + Z to undo and then enter 
smaller dimensions or lower resolution. It’s okay if the 
image appears to get smaller on your screen.
Step 3:  Choose File > Print to print it now, or save the 

photo to print later. If it’s being sent to someone 
else to print, choose File > Save As and pick TIF 
from the file format pop-up menu. TIFs can be 
opened in most image editors and are a lossless 
graphic format (high quality). You can also print 
directly from a native Photoshop or Elements 
document.



AppleUsers Spotlight | Issue 4, November 2009 23

Resize images

Next, it’ll pop open your email client, create a new message, attach the photo and 
allow you to specify just how big the photo should be via a handy pop-up menu at the 
bottom right.

That’s all there is to it! So get out there and start printing and emailing those images. 
And if you haven’t upgraded your copy of Elements yet, get with it. In this column series 
we’re going to be covering all kinds of wonderful new features that you are sure to enjoy. 
At the very least, download the 30 day trial and give it a spin.

Until next month, happy shooting!

Credits
Lesa is on a mission to teach the world to create – and use – better graphics. She’s a stock 
photographer and chief evangelist for iStockphoto and founder of the creative tutorial 
site GraphicReporter.com. Lesa is the author of “Photoshop: The Missing Manual” (O’Reilly, 
2008) along with many video training titles including “Graphic Secrets for Business 
Professionals” (Lynda.com, 2007), “From Photo to Graphic Art”, and “Practical Photoshop 
Elements” (KelbyTraining.com, 2008). She writes regularly for Macworld Magazine, 
National Association of Photoshop Professionals, Elements Techniques and Layers 
Magazine. Lesa is also a corporate trainer and teaches at many industry conferences 
including Photoshop World, Macworld Expo, Mac Mania Geek Cruises and the esteemed 
Santa Fe Workshops.

Since 2003, she has assisted New York Times technology columnist David Pogue’s with 
many projects, including his “Missing Manual” book series and NYT videos. You can catch 
her Graphics Tip of the Week live each Wednesday night on the Your Mac Life internet 
radio show, which she also co-hosts.

She spends her free time carving the twisties on her sportbike or hanging with fellow 
Mac geeks. Lesa is a proud member of the BMWMOA, F800 Riders Club, DACS, NCMUG, 
Washington Appe Pi and LiMac.

 – Lesa Snider King (http://www.graphicreporter.com/)

Picture 8. That’s all there is to it!
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O ne of the caveats of running a home office is the 
amount of information, documents and receipts 
that you deal with on a daily basis. Losing the post-

it notes you wrote down with the number of a potential 
client means losing potential business, so organisation is 
key.

Evernote allows you to document text files, audio 
files, image files screenshots, or even sections of web 
pages. You can tag and organise your data and they’re 
all searchable within the application. An amazing 
feature in Evernote is the ability to search for text within 
screenshots and image files. This is extremely effective, 
even when you make use of your Mac’s iSight camera 
or the iPhone’s camera to photograph documents (e.g. 
driver licenses or name cards) and search for them at a 
later date.

Evernote is free to use with a monthly upload limit 
of 40mb. But there is a premium version available if your 
needs increases. There are also different versions of the 
app available on the iPhone, Blackberry and Windows to 
enable you to sync your files across different platforms. 
And in addition, you can even manage your files through 
a web browser.

www.evernote.com

I f you are sick of the mountain of issues and 
inconsistent performance associated with running 
Microsoft Office and unwilling to fork out the dough 

for iWork 09, you might want to check out Neo Office. 
Neo Office is a suite of office apps that rival the 

big names. It includes word processors, formula-
spreadsheets applications and programs for building 
presentations. Neo Office is built on Sun Microsystem’s 
Open Office boasts improved stability and speed on the 
Mac OS.

Unlike Microsoft Office, Neo Office installs itself as a 
single app. The interface of Neo Office is consistent with 
the design of Mac OS and looks polished compared with 
Open Office.

Neo Office supports file types from Microsoft Office 
suite — it has no issues opening .doc, .xls or .pst files. 
Even the newer Microsoft Office 2007 files are handled 
with relative ease by Neo Office. This avoids the problems 
posed by Microsoft Office files sent by co-workers and 
clients.

www.neooffice.org

By Alvin Ng
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I f you don’t need the powerful search and 
organisational functions of Evernote and just want 
a quick and easy way to sync files across computers 

or platform in your home office, then Dropbox might be 
more suitable. 

Dropbox isn’t an app per se but more of a service. 
While there are countless other systems that allow you 
to sync files across machines, none do it with the finesse 
that Dropbox does. 

When you install Dropbox on your Mac, a Dropbox is 
created and any files you drag and drop into that folder 
will be sync across the different with which you’ve synced 
Dropbox. You can double click the files in the Dropbox 
folder and edit them like you would on any other files 
on your local machine’s folders. And when you save the 
file, it automatically updates the same file on the other 
Mac, thus making sure that you have the most up to date 
version which ever machine you’re working on.

You can also mange and update your files via 
Dropbox’s online interface so your files will always be at 
your fingertips even when you don’t have access to the 
application. The files you save in the sync folder are not 
only stored ‘in the clouds’ but also locally on your Mac, 
so if there is an event of a failure with Dropbox’s servers, 
your files are still safe on your local drive.

Dropbox is available on the Mac, Windows and iPhone 
and is free with a 2gb space online. Premium version of 
the app is available for a fee if you need larger space.

www.getdropbox.com

C yberduck is a free open-source file-transfer app 
on the Mac OS. Cyberduck pretty much does 
everything commercial FTP clients do but offers 

more features and integration services.  
The app has a very simple linterface. When you 

launch it, a pop up asking you to enter your FTP login and 
password appears from the main window. You can store 
multiple logins and passwords in the bookmark section 
of the app. This saves you from having to enter the 
details every time you login, and is handy if have multiple 
accounts for different web servers.

Besides FTP transfers, Cyberduck also supports 
FTPS, SFTP, WebDAV, MobileMe iDisk and Amazon S3. 

With support of such a vast array of online services and 
protocols, Cyberduck can be used as a quick and easy 
tool for online backups.

The app is also seamlessly integrated with editors like 
BBEdit and TextEdit so updates can be done to the files 
without having to transfer them. Another nifty feature of 
Cyberduck is the Quick Look function which allows you to 
preview files on your web server similarly to how you do 
in Finder.

Cyberduck is easy to use, free and support many 
languages making it one of the leading file transfer apps 
available today.

http://cyberduck.ch/

A party with 
Magical Bill

A gift 
guaranteed 

to please!
www.kew.hotkey.net.au/~billo

http://www.kew.hotkey.net.au/~billo
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How efficient are you on your Mac?

W hether you are a veteran or beginner on the Mac, 
efficiency is probably something you want your 
high-tech tools. Well, that and the occasional 

testosterone-pumping, GPU-overdriving game.
Most Mac users feel we are earning our Tiger, Leopard 

or Snow Leopard stripesas we discover and add to our 
repertoire another system, application shortcut or other 
power-user technique that we didn’t know. If that’s the 
case for you, please, read on.

One night, during a stretch of inefficiency, yours truly 
started to think of the many different ways we can access 
an often-visited or used document, app or folder. Just 
how many ways can we accomplish the same task?

Let’s take a look.
For our mind-bending example, let’s say we want 

to access a TextEdit document . Using as many Mac 
techniques as I could come up with, I offer you this 
‘baker’s dozen’. If you can come up with another to add to 
the list, share it with your fellow Mac users.

Now, let’s see how many of these techniques you 
have used during your Mac life (most, if not all, should 
work in Mac OS X Panther to Snow Leopard):
1. Leave it on your Desktop or Finder window
2. Apple Menu > Recent Items > Your Document
3. Create a hot key combination to directly open it
4. Drag and drop it to your Dock
5. Drag and drop it to the SIDEBAR of an open Finder 

window. It will now be there to click on in any Finder 
window opened from that point on.

6. Drag and drop to the TITLE BAR or TOP of a Finder 
window (same as to the sidebar area — tip: drag and 
hold the icon image there for 2-3 seconds before it 
will be placed)

7. Make an ALIAS of the file, put as many of those 
anywhere you want in as many places as you want

8. Turn Speech Recognition on (in System Preferences), 
then click once on your document to highlight it, and 
then say ‘Make this speakable’. And boom! It’s now 
something you can call up, literally, and open just by 
saying the name of the document!

9. Put an ALIAS of your document in “Startup  or Login 
Items” list (System Preferences or Accounts > Login 
Items) so that it automatically opens each time you 
boot up or log in.

10. Always keep it open, just minimize or hide in your 
Dock.

11. With your document up front, use Command + H to 
hide your document (and the app that created it). Use 
Command + Tab to toggle it back into your view. Yes, 
this is the same result as No. 10, but since it involves a 
different method, it counts.

12. Create an event alarm in iCal that launches your 
document at a specific date and time.

13. Print it out and tape it to your forehead. Okay, this one 

doesn’t count, but I was desperate. I was this close to 
having a full Bakers Dozen. Hmm, would mailing the 
document to yourself count?
I’ll end with this story of efficiency I heard from New 

York Times writer Thomas Friedman  during a lecture 
at Massachusetts Institute of Technology about his 
book,“The World Is Flat (3.0)”:

‘They were digging the tunnel under the English 
Channel to connect Great Britain and  Europe. They put it 
out for bids, and got many bids, some for 3 billion pounds 
or so. They also got one bid from Goldberg and Kohn, 
a small firm on the upper east end of London for only 
100,000 pounds. For fiduciary reasons they had to check 
it out, so they sent a team out to Goldberg and Kohn, 
knocked on the door, and Kohn answered (Goldberg 
was on the road): “Mr. Kohn, how can you possibly dig a 
tunnel under the English Channel for 100,000 pounds?”’

He said, ‘What’s the problem? Goldberg will start on 
one side, Kohn will start on the other; we’ll both have 
shovels, we’ll dig until we meet.’

They said, ‘What if you don’t meet?’
‘So you’ll have 2 tunnels!’

By Steve Welsh
Oregon MacPioneers User Group (Omug)
http://homepage.mac.com/ydkm/
Corvallis, Oregon, USA

How efficient are you on your Mac?
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Editorial through to Prepress

Editorial through to Prepress
— a personal experience

Pam Doughty <editor@ausom.net.au>

My experience is with the production of a print publication — AUSOM News — a 52-page magazine with 11 editions a year. The steps 
involved use computer applications and most records are retained and distributed in electronic form. Many steps or processes could be 
useful for a web-based, emailed, PDF or other format publication.

I perform all parts of the process with the assistance of two proofreaders. They review the text which I upload to a server, checking for 
typos and grammar. Basically, they ensure that the content makes sense.

I also choose to work with text files to which I add abbreviated tags for final placing in InDesign. In your own workflow you may 
prefer to use styled Word files. I have short AppleScripts that allow me to add a tag to a paragraph with a Keyboard shortcut. If I use the 
Keyboard shortcut Shift-5(numberpad) for Body Text within InDesign then I set the keyboard short cut for the Body Text tag in my text 
processor to also use the number 5 in some way.

tag
text text

in 4 Stages...
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 • PhotoShop (Photoshop).
 • Text Edit (TextEdit).
 • eg. (e.g.).
 • eg (e.g.).
 • etc (etc.). 
 • Ram (RAM). 
 • mac (Mac).

While testing my scripts I quickly discovered that some of these changes MUST be 
made to entire words only. For testing my scripts, I colour each changed word red to 
make the alterations obvious. It is easy to run scripts that change all text back to black.

In the next part of the script (highlight possible errors) there is another list of words 
that may need apostrophes. I don’t automatically change these, but highlight in a 
different colour. For example, SIGs; its; CDs; DVDs

After running this first script I run a spelling and grammar check. A word count gives 
me an idea of how many pages will be needed for the article. As a rough guide 900 
words on a page gives reasonable space for subheadings or sufficient white space to add 
interest. If necessary an article of 1100 words can be squeezed onto a page.

The text file is then uploaded for the proofreaders. While waiting for the files I have 
further work to do.

text

text

Initial Editorial Stage — Text
This stage commences with an array of files in various formats from plain text, RTF, 

Word files and PDF. Most are submitted as attachments in emails. Although I ask for plain 
text with images supplied as greyscale PDF, TIF or JPG, this seldom happens. In reality, 
even authors who have made submissions for many years have their own methods of 
‘assisting’ me by supplying information in a way that suits them. They are well aware that I 
have written personalised AppleScripts specifically to deal with their contributions which 
run first to remove their preferred contribution style.

I use Tex-Edit Plus – it is both scriptable and recordable. BBEdit would fill a similar 
need. I have very little knowledge of AppleScript and I make extensive use of scripts 
written by others, modifying them to suit my purposes. If the application is also 
recordable then it is possible for me to create simple scripts by recording my actions.

The first AppleScript (clean all files script) makes the following changes to the plain 
text file. Quote marks denote technical terms:

 • Replace multiple ‘Returns’ with a single ‘Return’.
 • Replace multiple ‘Spaces’ with a single ‘Space’.
 • Replace multiple ‘Tabs’ with a single ‘Tab’.
 • Remove spaces at the beginning of any lines (leading spaces).
 • Remove spaces after a full stop but before the ‘Return’ at end of line (trailing spaces).

The next part of this script alters words to fit with the publication style. Some of the 
these are:

 • Ausom (AUSOM).
 • Ausom’s (AUSOM’s). 
 • Sig (SIG).
 • sig (SIG).
 • Garage Band (GarageBand).
 • Garageband (GarageBand).
 • Applescript (AppleScript).
 • AddressBook (Address Book).

Semi-Design Phase — Text and Photoshop
The text file now requires tags to be added to identify headings, sub-headings, body 

text and so on.
The shortest form of tags for InDesign CS4 that I have worked out is:
<ASCII-MAC>
<vsn:6><fset:InDesign-Roman><ctable:=<Black:COLOR:CMYK:Process:0,0,0,1>>
<dps:Author>
<dps:Heading>
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tag

<ASCII-MAC>

<dps:SAuthor>
<dps:SHeading>
<dps:Body Text>
<dps:Heading Sub>
<dps:Caption>
<dps:Bullets>
<dps:Picture>
<dps:Liftout>
<dps:Monospaced>
<dps:Apple>
<pstyle:Author> (Author’s Name goes here)
<pstyle:Heading> (Heading Details go here)
<pstyle:Body Text> (Body Text — as many paragraphs as required)
<pstyle:Apple>z (This is actually the Command symbol which AUSOM uses at the end 

of each article)
NOTE: Placing text that has been tagged in this way adds one more task. InDesign 

is not going to like you using < or > within the text. It will generally give a warning and 
be quite OK, however to stop that warning, you need to add a \ before each < and >. 
This must be done before adding any of your tags, probably as part of your ‘clean all files’ 
script.

Exporting text from your own InDesign document — even using Abbreviated form — 
will give you something far more complex. You are welcome to try my abbreviated form 
of tags. To do so you need to replace Author with the paragraph style name you use for 
Author and so on for all your own tags.

From the above you can see that all text up to <pstyle:Author> is added to the 
beginning of each text file. Then an appropriate Tag is added to the first paragraph 
needing a new tag throughout the remainder of the document.

Tagging files for InDesign
For short articles it is easier to do this semi-manually. A tag can quickly be added to 

the beginning of a paragraph with an AppleScript associated with a keyboard shortcut.
For longer articles I use an AppleScript to add the Tags to the whole document. 

Sometimes these are modified to suit the style of the Author. The screen shot of an article 
may help to show what the script needs to do.

For AUSOM News each article has:
 • Line 1: <pstyle:Author>
 • Line 2: <pstyle:Heading>
 • Most other lines are <pstyle:Body Text>

If a line starts with ‘Fig’ then it is <pstyle:Caption> and it needs a blank line before it 
for a <pstyle:Picture>.

Any lines with less than 60 characters are subheadings or <pstyle:Heading Sub>.
Lines starting with • (or other) need the ‘• space’ or ‘• tab’ removed and tagged as 

<pstyle:Bullets>. The line AFTER this probably needs Body Text.
NOTE: Items marked * are a good guess but can also be incorrect often enough that I 

make the alteration but also colour it green. 
I prefer to apply styles for numbered points within InDesign. However, more often 

than not, I remove numbering as it is seldom necessary in the type of articles submitted.
The text file is then saved in my current working text folder.
Initially the Image files are kept in folders with the text of the article. ALL these files 

can be renamed to reflect the article name. There are folder scripts supplied with OS X to 
rename all files within a folder and I use those.

Groups of image files are then opened with Photoshop. I have written an AppleScript 
that:

 • Changes the image to greyscale,
 • Adjusts the size to 9cm width if it is currently more than 9cm, and
 • Saves the file as a PDF placing it into my current working images folder.
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InDesign
Once I have finished the editing of 

the text files I have a fairly good idea of 
where each will fit into the publication. 
At various times, I have tried setting up 
a grid showing all 52 pages and typing 
in the article names. But more often 
than not, it is easier to have that grid on 
a piece of paper and just hand write the 
information.

To place my first article, I go to the 
appropriate page. With the Text tool 
selected I drag across the Author-
Heading area, choose File>Place and 
select the text file. If errors have been 
made with the tags, InDesign will let me 
know and I can either continue or go 
back and have another look at the text 
file.

After refining the process such 
warnings seldom occur and the first few 
lines of the article will appear looking 
exactly as they should according to 
the Author and Heading styles within 
InDesign.

The remainder of the text can then be 
flowed into the columns as required.

I do make use of the ability to run 

AppleScripts for InDesign and have 2 so 
far. One to place text into the document 
with the heading area on the left hand 
page and one to do the same thing 
starting with a right hand page.

All that remains is to place the images. 
I have blank lines for pictures (and the 
line below Caption: Fig x) so I can place 
the image for Fig x at the insertion point 
in the picture line. With images ‘in-line’ 
text will re-flow. For long articles, I find it 
easier to insert the pictures while using 
Edit Story Editor. I am sure this process 
could be done using an AppleScript but 
I have never found the time to write the 
script.

I have spelling and other errors 
showing while working in InDesign. So 
while I am incorporating any changes 
suggested by the proofreaders, I try to 
avoid simply adding more typos.

I would prefer that the proofreaders 
worked with the PDF versions of each of 
the pages, but my volunteer proofreaders 
find it easier and quicker to work with 
text files and track changes in Word or 
Pages. If needed, a screen quality of each 
page could be provided at this stage for 
proof-reading purposes.

As each article is completed I create 
a Press Quality PDF for each page and 
upload it to a server.

In the event that I cannot complete 
AUSOM News any other Member of 
AUSOM could download as many 
pages of the magazine as are available. 
Technically, an emergency cover and an 
emergency front page saying something 
along the lines of “The Editor has died 
so your magazine this month has only 
the pages available at that time” could 
be available on that server. Our printer 
could, as a last resort, print an emergency 
magazine from these PDF files.

I have not bothered to create such 
documents — sometimes Editors really 
are mean, nasty people who believe 
some jobs could be done by others if 
there was sufficient interest.

Feature article designed by: 
Christine Soriano

http://www.s2d6.com/x/?x=c&z=s&v=2311276&r=[RANDOM]&k=spotlight


http://www.themacbundles.com
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Bean 2.4.0
Bean is an open source free word processor for Mac OS X 
that is “fully Cocoa”. 
Features include:

 • Live word count
 • A Get Info panel for in-depth statistics
 • Date-stamped backups and auto-saving
 • A zoom-slider to change the view scale
 • A page layout mode
 • Alternate colours (for those who don’t like the default 

appearance of black words on a white background)
 • A search (find) facility that supports regular 

expressions, dictionary, word completion and a 
floating windows option (like Stickies has)

It natively reads and writes file formats such as .rtf, .rtfd 
(rich text with graphics), .bean, .txt, .html and .webarchive 
(Apple archive format). It can also import and export to 
the Word formats (.doc, .docx, .xml) and OpenDocument 
(.odt) as well as export your document in the pdf format. 

(It should be noted that there are some limitations 
with some of these formats).

Express Invoice 2.04
Express Invoice is 
professional invoicing 
software for Mac that 
allows you to manage client 
accounts, create invoices 
and apply payments. 

You can create and 
generate professional-
looking invoices in just a few 
quick clicks using template 
choices. 

The emphasis is on 
speed. Creating an invoice in less than 30 seconds is very 
easy. You’re taken through a quick setup wizard where 
you can choose the template, the fields required, the 
type of document it should be and how many pages you 
need. When you’re done, you can preview, save, print 
or even send them by e-mail or fax directly from the 
application (if you have a fax client). 

The great thing is that once you’ve sent faxes and 
invoices using Express Invoice, you can track them and 
whether they’ve been settled, replied to, etc. You can 
make a record of when and how invoices were paid, 
how long it took to pay and see whether you’ve got any 
pending - very useful for businesses under pressure that 
don’t have a big admin department. 

You can create re-occurring invoices for ongoing 
services and link to credit card gateways to easily process 
payments for goods and services. It also includes a 
number of standard reports such as unpaid accounts, 
payments, sales person and accounting reports.

Express Invoice is a remarkably good tool for a 
free application that will give any small business a 
professional touch. 

FormulatePro 0.0.5b Free PDF-Editor
Have you ever received 
a form in pdf format 
that required you to fill 
in and return? Need to 
sign a PDF document 
and return it by email? 
You could print the 
form, fill it in, scan it 
into your Mac and 
email the document 
back. 

You could buy Adobe Acrobat or some other PDF-
editing software or use FormulatePro to do this by 
overlaying the original PDF document with text and/or 
graphics.

FormulatePro allows you to open and write on PDF 
documents. You can fill out any PDF document, drop in 
graphics, scribble with the mouse or a tablet, save and 
print.

There are six possible tools to interact with the 
document: the arrow tool (to drag everything around or 
move the document), a circle and rectangle tool (shape 
options for text boxes), a freeform line tool, a text-entry 
tool and a checkmark-shaped tool.

You will need to have OS X 10.4 Tiger or higher 
installed to run FormulatePro.

Free Mac Apps
Paul Sutcliffe

http://www.bean-osx.com/Bean.html
http://www.nchsoftware.com/invoice/index.html
http://download.cnet.com/FormulatePro/3000-2079_4-173863.html
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IBM Lotus Symphony 1.3
Completely free office suite for docs, sheets and 

presentations.
IBM Lotus Symphony offers three tools: word 

processor, spreadsheet and presentations. It’s true that 
other productivity suites are usually more complete. 

However, Lotus Symphony stands out for a 
convenient, single-windowed interface from which you 
can launch the three apps. Simply click on the “Open” 
button and select the kind of document you want to 
open: the program’s toolbar will change accordingly. 
What’s more, you can have as many opened documents 
as you want at the same time, no matter which type, and 
switch between them in the top tab bar. 

The suite includes all the basic tools that you could 
expect in such an application: spell checker and tables 
for documents, predesigned templates for presentations 
and charts for spreadsheets - to name a few - besides the 
usual configuration options for fonts, colours and the like. 
It supports a variety of file formats including Microsoft 
Office and Lotus SmartSuite

IBM Lotus Symphony offers a stable, highly functional 
productivity suite that, despite not being as complete as 
other suites, may perfectly fit your needs. 

XPad 1.2.6
xPad is the ultimate 

notepad – a TextEdit and 
Stickies replacement 
for Apple OS X. With 
a simple, easy-to-use 
interface and powerful 
multi-document features, 
xPad will quickly become 
your daily text editor of 
choice.

With xPad you can create as many documents as 
you like, all of which are managed in one window. 
Attached to that window is a drawer containing a list of 
all the documents you’ve created. Any document can be 
selected and loaded instantly – at any time – allowing 
you to easily create and manage hundreds of documents 
without cluttering your desktop.

Staying organised with xPad is easy. With the category 
editor you can create and colour-code categories, then 
quickly assign documents in the drawer. Documents 
can be sorted by name, date or category. Now you can 
efficiently manage limitless documents with colour 
coding that provides a constant reminder of your 
organisational scheme.

You can quickly rename documents, delete one or 
many, and export single, multiple, or all your documents 
in both Rich and Plain Text formats using both drag and 
drop or conventional panels. You can also instantly export 
to your iPod, allowing you to read your documents when 
you are away from your computer.

xPad automatically saves your work, so you never 
have to worry about manually saving what you’re 
working on or accidentally closing something without 
saving – and losing all your information.

http://symphony.lotus.com/software/lotus/symphony/home.nsf/home
http://getxpad.com/
http://www.s2d6.com/x/?x=c&z=s&v=2215686&r=[RANDOM]&k=spotlight
http://www.s2d6.com/x/?x=c&amp;z=s&amp;v=2190219&amp;k=dashboard
http://www.macnotables.com
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Peachpit
You can save 35% 
on all Peachpit 
books by becoming 
a Peachpit 
Club Member. 
Membership is free 
and easy. All you 

have to do is answer a few questions 
in Peachpit’s online survey, which 
you can access from any book page. 
After you fill out the survey, you’ll save 
35% by entering the coupon code at 
checkout. (You cannot use this discount 
in conjunction with any other coupon 
codes.)

Apple user group members get 35% 
off the normal price… PLUS, if you spend 
more than US$55 in one order, your 
discount will expand to 40%!!! 
Join the Club: http://www.peachpit.com
Coupon Code:  UE-23AA-PEUF 

(case-sensitive)
This worldwide offer is ongoing.

Mushkin Memory: Reseller Prices

Mushkin Perfect Match products for 
Apple are specifically designed for Mac 
users. They have been creating enhanced 
memory for more than a decade, and 
believe in providing the highest quality 
products at the best value. Mushkin 
PerfectMatch upgrades are the smart 
choice. They carefully select components 
and program each module to match the 
manufacturer-installed memory and 
provide guaranteed compatibility.

A user group web store is now 
available with the same pricing given 
to resellers (discounts of 20-40 percent) 
insuring the best possible price for all 
Mushkin Mac products.
Visit Mushkin’s special User Group Store
This worldwide offer is ongoing.

Softpress Freeway: 25% Discount
Freeway gives you 
all the legendary 
ease-of-use and 
features that 
launched the 
desktop publishing 

revolution. You can quickly and 
effortlessly lay out your website, embed 
images and content, then publish your 
work as standards-compliant HTML. 
Upload to your server, .Mac or to a 
folder. You supply the creativity, Freeway 
handles the code.

Apple User Group members can 
buy Freeway Pro, regularly US$249 for 
US$186.75, and Freeway Express for 
US$59.25, a 25% discount.
http://www.softpress.com/store
Promo code: AmuG50825iSreL1
This worldwide offer is ongoing.

user Group Discounts
Gary Lowen (gary@lowen.id.au)

Credits
Be sure to subscribe to the Apple User 
Group Market Report podcast. The AUG 
Market Report and Resource blog are 
great sources for information about 
Apple user groups, vendor discounts, 
special events, interesting reviews, 
stimulating training and more.

Apple User Group Market Report 
podcast: http://homepage.mac.com/
ugab/resources.html

For public information about vendor 
offers and more visit: http://homepage.
mac.com/ugab/offers.html

Does your company want to promote 
an offer, direct to over 5,000 Apple 
Enthusiasts? Use our contact form and 
select ‘Vendor Offers’ to tell us about 
your offer!

These User Group discounts are brought to you by the Apple User Group Advisory Board (special thanks to board member Tom Piper).
You must be a current Apple user group member to qualify for these savings. Not a member? Join an Apple user group today to take advantage of these special offers.

http://www.peachpit.com/
http://www.mushkin.com/doc/deals/appleusergroups/
http://www.softpress.com/store/
http://homepage.mac.com/ugab/resources.html
http://homepage.mac.com/ugab/resources.html
http://homepage.mac.com/ugab/offers.html
http://homepage.mac.com/ugab/offers.html
http://www.appleusers.org/about/


Festive Fun Volume II
A massive collection of Festive Fun for all ages to help celebrate and enjoy the Festive Season – Even Santa could use this Disc

3000+ pieces of Christmas Clip Art
Colour + Black & White images, Animated Images & Borders

990+ pieces of Christmas Music
Vocal, Instrumental, MIDI & Audio Books…Plus Videos

880+ Christmas Card & Gift Tags
Templates for Word, Pages Photoshop, GIF & PDF

600+ Christmas Activities
Christmas Colouring Sheets, Recipes & Craft Activities

300+ Christmas Fonts
TrueType, ready for use in virtually any application

35+ Christmas Applications 
Games, Icons, Widgets, Screen Savers & Desktop Decorations

30+ Christmas Stories
Supplied as PDF - some double as colouring Sheets. 15$all on a single

for j
ust
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Disc of the Month

You can purchase the Discs of the Month, including this 
month’s title, Camera Bag, from the following Apple User 
Groups;

 • http://homepage.mac.com/sydamug/amugmembers/
disc/orderform-nonmem.html - AMUG Sydney

 • www.ausom.net.au/discofthemonth - AUSOM 
Incorporated

 • www.beaut.org.au/tips.html - BEAUT
 • www.bsmug.ozshop.net - Byron Shire Mac User Group
 • www.cvmu.net - Central Victorian Macintosh Users Inc
 • groups.yahoo.com/group/coffs_mac_users - Coffs 

Harbour Mac Users Group
 • www.gmug.org.au/dotm/ - Geraldton Macintosh User 

Group
 • goin.to/gcusers - Gold Coast Apple Users Group
 • www.mactalkhunter.org.au - MacTalk Hunter
 • www.saauc.org.au - South Australian Apple Users 

Club
Disc of the Month CDs have a RRP of AUD$10, 

with DVDs costing AUD$15. However, many of these 
User Groups allow you to purchase the Discs of the 
Month from their meetings - often at a discount; or you 
can order via the web, postal mail, fax or telephone. 
Occasionally, special bundles are offered by the User 
Groups as well, so keep an eye on their websites.

Previous Discs
Most of the above user groups maintain an archive of 
previous Discs, so you can still order previous titles.

Publishing House was the first Disc of the Month 
we released to Australian Apple User Groups and it still 
contains some great tools for creating you own Greeting 
Cards, Envelopes, Flyers, Newsletters, Calendars, Banners, 
Signs, Posters and even CD & DVD Labels and Covers 
making Publishing House the perfect complement to the 
Festive Fun II DVD.

Disc of the Month

Celebrations
Galore

Turn your Mac in to an all round Publishing House,
with all the tools you need to generate your own;

✓ CD & DVD Labels, Covers & Inserts 

✓ Greeting Cards
✓ Envelopes & Labels

✓ Flyers & Newsletters
✓ Calendars & Scrapbooks

✓ Banners, Signs & Posters

Publishing

House

Celebrations Galore is a CD chockers full of Clipart, 
Animated Images, Fonts, Music & Movies, Colouring 
Books, Greeting Cards and Envelopes for use with 
Birthdays & Parties, Easter, Babies & Graduation, 
Halloween & Thanksgiving, Mother’s and Father’s Day, 
New Year’s, St Patrick’s Day and Valentines Day and 
Weddings. Celebrations Galore is an ideal supplement to 
the Festive Fun II DVD.

AppleUsers.org would like to gratefully acknowledge 
and sincerely thank Niche Media, the publishers 
of Australian Macworld, for supporting the Disc of 
the Month project by providing us with the server 
space and bandwidth to store and distribute the 
Golden Master Disc Image and support files to the 
participating Apple User Groups each month.
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